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Fiery proServer User Guide
Congratulations on your purchase of the EFI™ Fiery® proServer, a powerful production 
solution for your printer.

Before you begin
Make sure that you have:

• Installed the physical components of the Fiery proServer and activated the Fiery XF license 
(see Introducing EFI Fiery proServer and the Installation Guide)

• Set up the Fiery proServer for use with the printer (see the Quick Start Guide)

About this document
This document describes how to keep your Fiery proServer in good working condition after 
installation. It deals with the following topics:

• Fiery proServer front panel, including the control panel (see page 2)

• How to start, shut down and reboot the Fiery proServer (see page 4)

• Changing the language of Fiery proServer and Fiery XF (see page 8)

• Backing up the Fiery proServer system (see page 10)

• Returning the Fiery proServer system to an earlier state (see page 13)

• Reinstalling the Fiery XF license file (see page 15)

• Using anti-virus software (see page 17)

• Troubleshooting problems (see page 17)

Fiery proServer components
This section describes the hardware of Fiery proServer SE/Premium. It is not applicable to the 
embedded Fiery proServer, which has a different housing and no DVD drive.
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Front panel

The front panel consists of the following components:

Control panel

The control panel is located on the top front of the Fiery proServer.

Fiery proServer front panel
1 LCD and line selection 

buttons
2 DVD drive
3 Front USB ports
4 Reset button: DO NOT USE
5 Power button
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Fiery proServer control panel
1 Activity light (not used by 

Fiery XF)
2 Liquid crystal display (LCD)
3 Line selection buttons
4 Jewel
5 Buttons (used by installer)

1
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Precautions

Observe the following precautions when using the Fiery proServer control panel:

• Avoid pressing the surface of the liquid crystal display (LCD).

Applying pressure to the LCD causes it to change color.

• Use a soft cloth moistened with lens cleaner to clean the surface of the LCD. 

Other solvents, such as water, may damage the LCD.

• Handle the LCD with care.

If the LCD breaks and the liquid crystal inside leaks out, avoid contact. If you do come in 
contact with the liquid crystal, immediately wash it off your skin with soap and water.

Buttons

Commands

The LCD of Fiery proServer has four commands.

You can select a command by pressing the corresponding line selection button on the right 
side of the Fiery proServer control panel.

Line selection buttons Four line selection buttons on the right side of the Fiery proServer 
control panel that allow you to select the command displayed on the 
corresponding line of the LCD.

Up and Down buttons No functionality on the Fiery proServer.

Selection button No functionality on the Fiery proServer.

XF Client Start Starts Fiery XF to let you load, process, and output jobs.

XF Online Update Enables you to download software updates from the EFI website. It is 
recommended that you regularly search for and install all updates to 
ensure that your software is always up to date.

In Fiery XF you can check which updates are installed on your 
computer. From the Help menu, click Fiery XF Server Information. A 
list of currently installed updates is displayed on the Installed XF 
Updates tab.

XF Profile Update Enables you to download additional media profiles from the EFI 
website.

XF Homepage Opens the Fiery XF homepage which provides information about new 
program versions and output options.
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Shutting down, rebooting, and starting the Fiery proServer
Generally, you can leave the Fiery proServer and the printer running all the time. This section 
describes how to shut down, and reboot the Fiery proServer when necessary.

Always use the following procedures. Do not use the reset button on the front of the Fiery 
proServer to shut down or reboot the system.

TO SHUT DOWN THE FIERY PROSERVER

1 Verify that the Fiery proServer is not receiving, processing, or printing any files.

If the system has just finished processing, wait at least five seconds after the system reaches 
Idle before you proceed.

2 Exit Fiery XF.

On the File menu, click Exit to close the Fiery XF client. Then, right-click Fiery XF Control 
and click Fiery XF Server Stop to stop the Fiery XF server.

3 Move the mouse pointer to the lower-left corner of the screen to see the Windows icon.

4 Right-click the Windows icon, point to Shut down or sign out, and then click Shut down.

Allow the system to shut down completely.

TO REBOOT THE FIERY PROSERVER

If a USB flash drive is attached to the Fiery proServer, remove it before rebooting. Otherwise, 
the Fiery proServer will not reboot.

1 Verify that the Fiery proServer is not receiving, processing, or printing any files.

2 Exit Fiery XF.

On the File menu, click Exit to close the Fiery XF client. Then, right-click Fiery XF Control 
and click Fiery XF Server Stop to stop the Fiery XF server.

3 Move the mouse pointer to the lower-left corner of the screen to see the Windows icon.

4 Right-click the Windows icon, point to Shut down or sign out, and then click Restart.

Wait for the system to reboot and the login window to appear on the monitor.

5 Enter the Admin password, and then press <Enter>.

Fiery.1 is the default Admin password and is case-sensitive. However, your administrator may 
have changed the password. If the password is lost, you must reset the Fiery proServer to its 
factory state. For more information, see “Returning the Fiery proServer to an earlier state” on 
page 13.

When you have logged on, the Fiery proServer desktop appears.
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TO START THE FIERY PROSERVER

1 Set the power switch on the back of the Fiery proServer to the On (|) position. 

FIGURE 1: Fiery proServer power switch

2 Power on the Fiery proServer. 

Press once and release the button to power on the system. The power supply automatically 
senses the correct voltage.

FIGURE 2: Fiery proServer power button

3 At the Admin logon on the monitor, enter Fiery.1 in the password field, and then press 
<Enter>.

Type Fiery.1 exactly. The password is case-sensitive; for example, fiery.1 will not work. 
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4 Allow startup to proceed until the Fiery proServer desktop appears on the monitor, and the 
Fiery XF commands appear on the control panel located on the top front of the Fiery 
proServer.

The Fiery proServer takes approximately two minutes to start up.

By default, the Windows taskbar is hidden. The taskbar contains:

•  Fiery XF Control, a tool for controlling the Fiery XF server

•  Fiery System Tools, a tool for changing the language of the operating system and 
keyboard, Fiery XF Control, and Fiery XF

5 To display the Windows taskbar, do one of the following:

• To display the taskbar, move the pointer to the bottom of the screen.

• To display the taskbar at all times, right-click the taskbar and then click Settings. In the 
Settings dialog box, click the Taskbar tab, set “Lock the taskbar” to on, and set 
“Automatically hide the taskbar in desktop mode” to off. Close the dialog box.

The Fiery XF Control icon is not immediately visible in the status area of the taskbar. Click 
the up arrow to show hidden icons, and then drag the Fiery XF Control icon from the hidden 
icon area to the status area.

Fiery XF
Fiery XF is a fast, high-performance raster image processor (RIP) that boosts color quality and 
productivity for your printer.

Starting Fiery XF

Fiery XF starts automatically whenever you start the Fiery proServer. If you exit Fiery XF for 
any reason, you can restart the program as follows:

TO START FIERY XF

1 Do one of the following:

• Double-click the Fiery XF client icon on the desktop.

FIGURE 3: Fiery XF client icon

• Right-click Fiery XF Control, and click Fiery XF Client Start.
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• Press the line selection button for the “XF Client Start” command on the Fiery proServer 
control panel.

The Welcome screen appears every time you start Fiery XF. It is divided into three sections: 

• “What’s new” provides information on new program features, improvements, and added 
printer support.

• “Did you know” contains use cases and hints on how to use specific Fiery XF features.

• “Your Software Maintenance and Support Agreement” shows the status of your Software 
Maintenance & Support Agreement (SMSA). You can renew your SMSA by clicking on 
the link in this section. 

If you do not want the Welcome screen to be displayed at every startup, clear the “Show on 
application start” check box. However, reminders to renew your license are still displayed 90 
days, 30 days, and seven days before the due expiration date. To display the Welcome screen 
again on demand, click the appropriate item on the Help menu in Fiery XF. 

Accessing Fiery XF help

Fiery XF includes a comprehensive help system:

• The application help provides detailed information on how to set up and use each feature 
of Fiery XF. From the Help menu, click Help.

• The context-sensitive help gives a brief description of the settings on each pane. You can 
access the context-sensitive help via the menu buttons in property inspector. Right-click a 
menu button on the right of a pane bar, and click Help.

Updating the software
Before setting up Fiery XF, make sure that your software is up to date. To update the software, 
the Fiery proServer must be connected to the Internet.

It is essential to ensure that you have the latest version of Fiery XF installed on your computer. 
Search for available program updates to make sure that your version of Fiery XF is up to date.

TO CHECK FOR FIERY XF UPDATES

1 Press the line selection button for “Online update” on the control panel of the Fiery 
proServer. 

2 Select and download any available updates. 

Make sure to download each update one at a time in numerical order. Repeat the process until 
no further updates are shown.
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Changing the language

Changing the language of the Fiery proServer

If needed, you can change the system language.

NOTE: The language change takes up to 15 minutes to complete. When the language change is 
in progress, it cannot be aborted.

The language change is applied to the operating system, Fiery XF Control and Fiery XF.

TO CHANGE THE LANGUAGE OF THE FIERY PROSERVER

1 In the Windows taskbar at the bottom of the screen, click the Fiery System Tools icon.

FIGURE 4: Fiery System Tools 

2 Follow the on-screen instructions to select a new language.

At the end of the language change, Windows restarts automatically.

Changing the language of Fiery XF

Fiery XF has its own language setting which overrides the language setting made for the Fiery 
proServer. This makes it possible to display Fiery XF in a different language from the 
operating system and Fiery XF Control.

TO CHANGE THE LANGUAGE SETTING FOR FIERY XF

NOTE: To display one of the supported Asian languages, Fiery XF must be running on an 
operating system that supports double-byte fonts.

1 In System Manager, on the Edit menu, click Languages and then click a language.

2 Restart the Fiery XF client for the new language to take effect.

Managing your Fiery proServer system

Fiery proServer SE/Premium

You can use the System Software DVDs to reinstall the Fiery proServer system or to return it 
to an earlier state. When you insert System Software DVD 1, the first screen lets you select 
the language in which the Fiery proServer system is installed. The language selection is 
applied to the operating system, Fiery XF Control and Fiery XF. For more information, see 
“Reinstalling the Fiery proServer system” on page 15.
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The second screen provides the following menus:

Embedded Fiery proServer

If you have an embedded Fiery proServer you can use Fiery System Tools to reset the system 
to its factory default, or to return it to a backed up state. Fiery System Tools is installed as an 
icon in the taskbar.

To create a backup, you require a USB stick or an external hard drive. The data storage 
medium must have a minimum of 32 GB storage space, have no more than one partition, and 
be formatted to NTFS.

Command Description

New Installation Deletes all the data on the hard disk drives (HDDs), and installs the 
Fiery proServer system from a data storage device, such as a DVD or a 
USB drive. For more information, see “Returning the Fiery proServer 
to an earlier state” on page 13.

Restore from backup or 
recovery partition

Deletes all the data on the hard disk drives, and returns the Fiery 
proServer system to its factory state from a hidden partition on the 
hard disk drive, or to an earlier state from a backup. For more 
information, see “Returning the Fiery proServer to an earlier state” on 
page 13.

Back up hard disk drive(s) Saves a backup of the hard disk drive to a data storage medium, such as 
a USB drive, an external hard disk drive or a network location. You can 
use a backup to return your system configuration to an earlier state. 
For more information, see “Backing up the Fiery proServer system” on 
page 10.

Platform utilities • Permanently deletes all the data from the hard disk drives.

• Opens Windows Task Manager for gathering platform-specific 
information.
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Fiery System Tools window provides the following menus:

Backing up the Fiery proServer system
Creating a backup of your current Fiery proServer system enables you to restore the system to 
an earlier state without having to return it to its factory settings. It is recommended that you 
back up your Fiery proServer system to an external hard disk approximately once every three 
months.

Be aware that job files can be backed up, but not the output files that reside in the Export 
folder due to their size.

NOTE: Backing up the Fiery proServer system can take up to one hour, depending on the 
backup medium used and the volume of job data.

The steps described below require you to insert System Software 1 DVD. All Fiery proServers, 
including the embedded Fiery proServer, are now shipped with a Fiery System Tools icon pre-
installed on the taskbar. This tool provides an alternative method to back up and restore 
system settings, or to return your system to its factory state.

Command Description

Back up your system Saves a backup of the hard disk drive to a data storage medium, such as 
a USB drive, an external hard disk, or a network location. You can also 
create a backup in a subfolder of the local hard disk.

View backup history Displays the date and time of created backups.

Restore system from a 
previous backup

Deletes all the data on the hard disk drives, and returns the Fiery 
proServer embedded system to an earlier state from a backup.

Restore to factory defaults Reinstalls the Fiery proServer embedded system from a hidden 
partition on the hard disk drive. This operation causes all system data 
to be lost.

Restore a backup made on a 
previous system

Restores an existing backup to a new embedded Fiery proServer 
system.

Create system recovery 
media

Saves a bootable copy of the system’s recovery partition to a data 
storage medium, such as a USB drive, or an external hard disk. You can 
use a system recovery to return an embedded Fiery proServer to an 
earlier state — for example, after the hard disk has been replaced but 
no backup is available, or the backup exists as a network fileshare.

Change system language Changes the language of the operating system and keyboard, 
Fiery XF Control, and Fiery XF.

Create network fileshare 
setup file

Allows you to set up a shared network folder with access credentials for 
backup and restore purposes.

Set up e-mail notification Allows you to receive an e-mail notification when the installation, 
backup, or restore is complete, which can take more than an hour.
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If you have an embedded Fiery proServer, you must use Fiery System Tools, as the hardware 
does not come with a DVD drive and installation DVDs. To start Fiery System Tools, double-
click the icon on the taskbar, and follow the on-screen instructions. For more information, see 
“Embedded Fiery proServer” on page 9.

TO BACK UP YOUR FIERY PROSERVER SYSTEM

1 Exit Fiery XF.

2 Insert the System Software 1 DVD.

3 Reboot the Fiery proServer (see page 4). When the reboot process starts, press <F11>.

4 When asked to select a boot device, press <Enter>.

Wait for the system to boot from the DVD and for Windows to load the installation files. 
This takes a few minutes.

5 Continue with the on-screen instructions until you are requested to select a language from 
the drop-down list box.

This is the language used to lead you through the backup procedure.
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6 Connect the data storage medium for the backup.

If you use an external hard disk, make sure that it has 500 MB free disk space and is set up as 
an NTFS volume. Make sure also that no other USB device is connected at the same time.

7 When asked what you want to do, click “Back up hard disk drive(s)”.

8 At the “Backup settings” screen, do the following:

• Specify the type of data storage medium you want to use as the backup destination.

You can choose from USB drive, DVD, network share, or external hard disk drive.
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• Clear the option to include job files resident on the Fiery proServer in the system backup.

• Clear the option to create bootable media.

It is recommended that you do not create a bootable backup. Certain computer settings 
are required in order to boot from a backup medium. Your computer may not be set up for 
this.

9 Click Start backup, and continue to follow the on-screen instructions to back up the system 
disk(s).

10 When prompted, remove the System Software 1 DVD. Remove also the external data storage 
medium. Then, press any key to restart Windows.

NOTE: It is recommended that you save a copy of the Fiery XF license. For more information, 
see “Saving your Fiery proServer configuration” on page 16.

Returning the Fiery proServer to an earlier state
It may occasionally be necessary to return the Fiery proServer system to an earlier state. You 
can do this by:

• Using a backup that you have previously created

Fiery XF is restored with all the settings, including system environments, that were current 
at the time the backup was created. Any settings made after the backup was created are 
lost. For more information, see “Backing up the Fiery proServer system” on page 10.

• Returning the Fiery proServer system to its factory state

The Fiery XF license and all your Fiery XF settings, including system environments, are 
deleted from the hard disk drives. You need to return the Fiery proServer to its factory 
state, for example, if the default password has been changed and misplaced.
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• Reinstalling the Fiery proServer from scratch

The Fiery XF license and all your Fiery XF settings, including system environments, are 
deleted from the hard disk drives. You need to reinstall the Fiery proServer from scratch, 
for example, after replacing a defective hard disk drive.

Restoring the Fiery proServer from a backup/Returning the Fiery 
proServer to its factory state

Returning the Fiery proServer system to an earlier state can take up to one hour, depending 
on the backup medium used and the volume of job data being restored.

The steps described below require you to insert System Software 1 DVD. All Fiery proServers, 
including the embedded Fiery proServer, are now shipped with a Fiery System Tools icon pre-
installed on the taskbar. This tool provides an alternative method to back up and restore 
system settings, or to return your system to its factory state.

If you have an embedded Fiery proServer, you must use Fiery System Tools, as the hardware 
does not come with a DVD drive and installation DVDs. To start Fiery System Tools, double-
click the icon on the taskbar, and follow the on-screen instructions. For more information, see 
“Embedded Fiery proServer” on page 9.

TO RESTORE THE FIERY PROSERVER FROM A BACKUP/TO RETURN THE FIERY PROSERVER SYSTEM TO ITS FACTORY 
STATE

1 Exit Fiery XF.

2 Insert the System Software 1 DVD.

3 Reboot the Fiery proServer (see page 4).

Wait for the system to boot from the DVD and for Windows to load the installation files. 
This takes a few minutes.

4 If you are restoring the Fiery proServer system from a backup, insert the backup medium.

5 Continue with the on-screen instructions until you are requested to select a language from 
the drop-down list box.

This is the language used to lead you through the restore procedure.

6 When asked what you want to do, click “Restore from backup or recovery partition”.

7 When asked to select a backup source, choose one of the following:

• Click “Restore from recovery partition” to return the Fiery proServer system to its factory 
state.

• Click “Search for backups from this system” to restore a previously created backup.

8 Continue to follow the on-screen instructions. If prompted, confirm that you want to erase all 
the data on the hard disk drive.

At the end of the procedure, Windows starts automatically.

If you returned Fiery proServer to its factory state, you must now reinstall the Fiery XF 
license. If you restored Fiery proServer from a backup, the license is already installed.
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Reinstalling the Fiery proServer system

Reinstalling the Fiery proServer can take up to one hour.

The steps described below require you to insert System Software 1 DVD. All Fiery proServers, 
including the embedded Fiery proServer, are now shipped with a Fiery System Tools icon pre-
installed on the taskbar. This tool provides an alternative method to back up and restore 
system settings, or to return your system to its factory state.

If you have an embedded Fiery proServer, you must use Fiery System Tools, as the hardware 
does not come with a DVD drive and installation DVDs. To start Fiery System Tools, double-
click the icon on the taskbar, and follow the on-screen instructions. For more information, see 
“Embedded Fiery proServer” on page 9.

TO REINSTALL THE FIERY PROSERVER SYSTEM

1 Do one of the following:

• If the Fiery proServer is running, exit Fiery XF. Insert the System Software 1 DVD and 
reboot the Fiery proServer.

• If the Fiery proServer is frozen or unresponsive, hold down the power button on the front 
panel until the system powers off. Press the power button once to power on the system and 
immediately insert the System Software 1 DVD.

Wait for the system to boot from the DVD and for Windows to load the installation files. 
This takes a few minutes.

2 When requested, select a language from the drop-down list box.

This is the language used to lead you through the installation procedure.

3 When asked what you want to do, Click “New Installation”.

4 Click Continue to confirm that you want to erase all the data on the hard disk drive.

5 Continue to follow the on-screen instructions. When requested, insert first the 
System Software 2 DVD and then the System Software 3 DVD.

At the end of the procedure, Windows starts automatically. You must now install the Fiery XF 
license. 

Reinstalling the Fiery XF license

If you have just reinstalled the Fiery proServer system or have returned the Fiery proServer 
system to its factory state, you need to reinstall the Fiery XF license. 

TO REINSTALL THE FIERY XF LICENSE FILE

1 Make sure that the dongle is inserted firmly into a USB port on the back panel of the Fiery 
proServer and that the dongle LED is lit.

2 Do one of the following:

• In the Fiery proServer Configuration dialog box, click Activate Fiery XF.
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• Right-click Fiery XF Control, and click Activate Fiery XF.

3 When asked if you want to allow the following program to make changes to this computer, 
click Yes.

The EFI Activation Wizard starts.

4 Read carefully the License Agreement. Then click Accept to accept the terms of the license 
agreement.

If you do not accept the terms of the License Agreement, the licensing process is aborted.

5 Click the Automatically tab.

6 Select “Download previously created license”, and click Download Activated Licenses.

A license file is created and downloaded to the FlexLM folder on your computer.

If problems arise when trying to download a license file, go to 
http://activation.efi.com, and follow the on-screen instructions to generate a license file. You 
can receive a license file that has been generated by the activation website by e-mail or by 
saving it to a specified location on your computer. To install the license file, follow steps 1 to 4 
above. Then, on the Manually tab, click Install License and browse to the license file.

7 Click Finish to exit the Activation Wizard.

8 Restart your computer.

The Fiery proServer restarts.

Saving your Fiery proServer configuration
After you have set up your Fiery proServer system, it is recommended that you do the 
following:

• Save a backup of the Fiery XF system to a USB drive, network share, or external hard disk 
drive. For more information, see “Backing up the Fiery proServer system” on page 10.

The system backup enables you to restore the system to an earlier state in case of a 
problem. The backup procedure may take up to one hour, depending on the backup 
medium used and the volume of job data.

• Save a backup of the Fiery XF license file to a network share or removable media drive. 
The license file is located in C:\Program Files (x86)\FlexLM on the Fiery proServer.

The backup license file enables the site administrator to reactivate the Fiery XF license 
after restoring the Fiery proServer to its factory state. Alternatively, you can download the 
license again from the activation website. For more information, see “Reinstalling the Fiery 
XF license” on page 15.

• Store the Entitlement Access Code (EAC) and all media shipped with the Fiery proServer 
in a safe location, accessible to service personnel in case of a future service call.

The System Software DVDs and the Entitlement Access Code enable you to reinstall the 
Fiery proServer from scratch.

http://activation.efi.com
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Anti-virus software
The Fiery proServer does not come with anti-virus software preinstalled. In production 
environments in which files are regularly exchanged with customers, it is strongly 
recommended that you install an anti-virus program of your choice.

When installing an anti-virus program, make sure that the following network ports are not 
blocked as they are needed for specific features of Fiery XF:

If you install an anti-virus program, it is recommended that you do not disable virus detection 
for jobs.

Troubleshooting problems
The following sections describe the source of common problems that may occur with the 
Fiery proServer, and suggest ways of correcting them. 

Checking the Fiery proServer configuration

This section describes the quick checks that you can do to make sure that the problem is not 
caused by an incorrect Fiery proServer configuration.

Verify the following:

The Fiery proServer starts up normally.

If, during startup, you hear 4 beeps, followed by 3 beeps, followed by 1 beep, followed by 
2 beeps, there may be a problem with the memory. Contact your authorized service/support 
center.

Port Used for

4108 Epson Spectroproofer

8010 Bi-directional communication service

8020, 8022 Integration and connectivity between Fiery XF server and EFI printers

8051, 8052, 8053, 8054, 
8061, 8062, 8063, 8064

Communication between Fiery XF server and APPE processes (up to 
four instances)

27000 to 27009, 60000 License management/EFI Cut Server

50005 to 50026 General communication between Fiery XF server and Fiery XF client

20020 to 20021 (UDP only) Fiery XF discovery
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The Fiery XF Control icon is green, indicating that Fiery XF Control is running.

The Fiery XF Control icon is located in the Windows system tray. If the icon is red, try the 
following:

❑ Right-click the icon and choose Fiery XF Server Start from the shortcut menu. 

Observe the Fiery XF Control dialog box that appears as Fiery XF searches for the dongle and 
license.

If the dongle is found, the dialog box displays the dongle ID and continues searching for the 
license.

• If the dongle and license are found, the dialog box closes and the Fiery XF Control icon 
turns green.

• If the dongle and license are not found, the dialog box closes and the Fiery XF Control 
icon remains red. Verify that the Fiery XF dongle is securely connected as described below, 
and choose Fiery XF Server Start again; if the Fiery XF Control icon is still red, you may 
need to reinstall the Fiery XF license, as described on page 15.

❑ Verify that no unauthorized software is installed on the Fiery proServer.

Third-party applications are not supported and can cause system problems. Although 
antivirus software is permitted on the Fiery proServer, you should run virus scans only when 
the Fiery proServer is in Idle mode (not processing or printing any jobs).

❑ Verify that the Fiery XF dongle is present and securely connected to a USB port on the back of 
the Fiery proServer, and the dongle LED is lit.

If the dongle is connected to a USB port but the dongle LED is not lit, try the following 
suggested actions. If the problem persists after performing an action, go on to the next action.

• Connect the dongle to a different USB port on the back of the Fiery proServer.

• Open the Device Manager in Windows and verify that the dongle driver is installed 
correctly.

• Perform a Windows update.

• Reinstall the dongle driver from the manufacturer’s site: ftp://ftp.aladdin.com/pub/hasp/
Sentinel_HASP/Runtime_%28Drivers%29/Sentinel_HASP_Run-time_setup.zip

• Obtain and connect a different dongle.

The connection to the printer is properly configured. 

Try the following:

❑ Use Fiery XF to print a test job to the printer.

For more information, see the Fiery XF online Help and the documentation that accompanies 
the printer.

❑ Reboot the printer. 

If the problem persists, you may need to test and service the printer. For more information, 
see the documentation that accompanies the printer.

ftp://ftp.aladdin.com/pub/hasp/Sentinel_HASP/Runtime_%28Drivers%29/Sentinel_HASP_Run-time_setup.zip
ftp://ftp.aladdin.com/pub/hasp/Sentinel_HASP/Runtime_%28Drivers%29/Sentinel_HASP_Run-time_setup.zip
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❑ Verify that the problem is not caused by a particular print job or application.

Try printing a different job or using a different printing application.

The network is functioning, and the Fiery proServer is properly connected to 
the network.

Verify the following:

❑ The Fiery proServer appears in the list of computers on the network.

If the Fiery proServer does not appear in the list of computers on the network, another device 
on the network may have been assigned the same Ethernet hardware address. 

❑ The Fiery proServer DHCP setting matches the DHCP setting of the customer’s network.

If DHCP error messages appear on the monitor, the Fiery proServer may be searching for a 
nonexistent DHCP server. DHCP is enabled by default on the Fiery proServer, but the 
customer’s network may not be using DHCP. In this case, you need to configure a static IP 
address for the Fiery proServer.

If the problem persists, proceed to “Checking interface connections” on page 20.

Display of hidden files in the Program Data directory is enabled

You must be able to access some files in the Program Data directory for certain 
troubleshooting purposes.

TO DISPLAY HIDDEN FILES

1 Move the mouse pointer to the lower-left corner of the screen to see the Windows icon.

2. Right-click the Windows icon, and then click Control Panel.

3 Set Control Panel to view by small icons.

4 Click File Explorer Options, and then click the View tab.

5. Under Advanced Settings, select Files and Folders > Hidden files and folders, and click “Show 
hidden files, folders, and drives.”

6. (Optional) Deselect “Hide extensions for known file types.”

7. Click OK to confirm the changes.

JobFolder directory is shared.

The JobFolder directory must be shared to allow access to hotfolders.

TO ENABLE SHARING WITH THE JOB FOLDER DIRECTORY

1. On the D:\ drive, right-click the “Jobs” folder and click Properties.

2. On the Sharing tab, click Advanced Sharing.

3. Select “Share this folder”. Then, select “Everyone” and click Permissions.

4. Set the permission level to “Read and change” and then click Apply.

5. Click OK to confirm the changes, and close all windows.
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Output folder is shared

The Export directory must be shared so that the printer has access to pull output files from 
the Fiery proServer.

TO ENABLE SHARING WITH THE OUTPUT FOLDER

1. Right-click the Output folder and click Properties.

Depending on your model of Fiery proServer, the Output folder is located either on the D:\ 
or E:\ drive.

2. On the Sharing tab, click Advanced Sharing.

3. Select “Share this folder”, and click Permissions.

4. Select “Everyone”, and then set the permission level to “Read and change” and then click 
Apply.

5. Click OK to confirm the changes, and close all window.

Checking interface connections

This section describes the quick checks that you can do to make sure that the problem is not 
caused by a loose connection at the back of the Fiery proServer.

Verify the following:

❑ All components and interface cables to the system are securely plugged into the correct ports 
on the back of the Fiery proServer. After verifying the connections, reboot the Fiery 
proServer.

For an illustration of the correct ports and connections at the back of the Fiery proServer, see 
Introducing EFI Fiery proServer.

❑ The power cable is plugged into the power outlet, and the Fiery proServer is powered on.

For more information, see “To start the Fiery proServer” on page 5. If the Fiery proServer 
does not start, try replacing the power cable with a new or tested cable.

❑ The upper LED next to the network port is on or blinking to indicate network activity.

If the upper LED is off, verify that the network cable is properly connected to the correct 
network port on the Fiery proServer and to the network device on the customer network. If 
the problem persists, try replacing the network cable with a new or tested cable.

Troubleshooting corrupted system software

If verifying the Fiery proServer configuration and connections do not correct the problem, the 
problem may be caused by corrupted system software. 

To remedy the problem, restore the Fiery proServer system to an earlier state as described on 
page 13. 
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